USC Psychology 314L (52610)

. Experimental Research Methods
Dornsife Fall 2014

Dana and David Dornsife
College of Letters, Arts

a}r)ld Sciences _ Lecture Location: Seeley G. Mudd Building (SGM), Room 226
epartment of Psychology .
- A Days and Time: Monday & Wednesday; 2:00 p.m. to 3:20 p.m.

ALL Labs Location: King Hall, Room 208
Wednesday Lab Time: 12:00 p.m. to 1:50 p.m.
Thursday Lab Time: 10:00 a.m. to 11:50 a.m.

Online portion at http://blackboard.usc.edu

Instructor Information

Dr. Clayton L. Stephenson Office Location: SGM, Room 526
Lecturer Office Hours: Tuesday, Thursday, & Friday
clstephe@usc.edu 10:00 a.m. — 12:00 p.m.; and by appointment

(213) 740-9019

TA Information
Peter Meindl
meindl@usc.edu

Syllabus

Course Description

Psychology is a science. Science requires specific methods that tests, supports, or disconfirms
hypotheses that lend supporting evidence or no evidence to a theory. Therefore, the course you
are about to take is one of the most important courses you will take in psychology. Without
rigorous, systematic research methods, much of the theoretical and practical knowledge we have
about perception, cognition, attitudes, learning, human development, stereotypes, and many other
areas in psychology would not exist. Although this course is not content specific, the knowledge
and content of the course can be applied to any content specific course in psychology and
neuroscience. You will learn about the philosophy of science, the various types of methods
psychologists use, how to conduct an experiment, and write a research paper adhering to the
Publication Manual of the American Psychological Association.

Prerequisites
PSYC 100 (Introduction to Psychology)

PSYC 274 (Statistics I)
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Teaching Obijectives
e Provide students with the fundamental knowledge of experimental research methods and design
used in psychology.
o Facilitate students understanding for how using valid scientific methods can improve and create
knowledge in the field of psychology.
e Guide and mentor students in developing, completing, writing, and presenting a valid and ethical
psychology experiment.

Student L earning Objectives
After successfully completing this course, students will be able to . . .
o identify areas in psychology in which they have strong interests.
e describe and discuss the concepts in various psychological research methods and design.
e critically analyze scientific claims made in popular and academic media.
o analyze and interpret quantitative data.
o collaborate and complete psychological research projects with their peers.
o verbally present their research findings in a coherent and concise manner.

Required Texts

American Psychological Association. (2010). Publication manual of the American psychological
association (6™ ed.). Washington, DC: American Psychological Association.

Goodwin, C. J. & Goodwin, K. A. (2013). Research in psychology: Methods and design (7" ed.).
Hoboken, NJ: John Wiley & Sons, Inc.

Beins, B. C. & Beins, A. M. (2012). Effective writing in psychology: Papers, posters, and presentations
(2" ed.). Hoboken, NJ: John Wiley & Sons, Inc.

NOTE: Goodwin & Goodwin textbook is abbreviated as (GOOD) in the schedule. Biens & Beins

textbook is abbreviated as (BEINS). The Publication Manual is abbreviated as (APA).
Supplemental Readings. (Various dates). Posted on Blackboard.
NOTE: Texts are available at the bookstore or online.

Assessment Due Date | Percent of Final Grade: Points
Blackboard CT Assignments Each Tuesday 15 (individual grade): 10-20
Research Proposal October 30" & 31%tat 11:59 p.m. | 15 (individual grade): 100

Final Research Paper December 12th at 11:59 p.m. 25 (individual grade): 100
Research Project Presentation December 12" 15 (individual grade): 100

Lab Assignments Continuous 20 (individual or group): 10-20
Participation = Lecture (5%) + Continuous 10 (individual or group): 5-20
Lab (5%)

Blackboard Critical Thinking (CT) Assignments

Each week you will complete a critical thinking assignment that will be posted on Blackboard. The
assignments are designed to help you comprehend or apply the material covered for that week. The
assignments will also prepare you for lecture-discussion sections on Wednesdays. These assignments are
due Tuesdays at 11:59 p.m. No assignment is due the first week of class.
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Research Proposal & Final Research Paper

You will write a research proposal throughout the first half of the semester and collect data in accordance
to your proposal during the second half of the semester. The research proposal is an important process in
providing a clear statement of the problem, an argument for the purpose of your study using appropriate
sources, how previous studies relate to your study, formal research questions and hypotheses, a full
methods section, and a data analysis plan. The final research paper will be the result of your semester’s
lab work and a demonstration of your ability to apply your knowledge so that you have a real
experimental study to report. You will work in groups of three or four to in completing the project, but
you will write the proposal and final paper individually. Please Note: These two papers are 40% of your
grade, so be diligent in writing your paper and getting help from me or your lab instructor immediately if
you have any problems.

Research Project Presentation

In place of a final exam, you will present your research study with your group. Presentations are
presented in a conference format and must be professional. You may be as creative as you want to be in
presenting your study and PowerPoint is NOT required. Please Note: The presentation is 15% of your
grade, so you will be held to high expectation and standards.

Weekly Lab Assignments

The lab assignments are designed for you to acquire the necessary skills, knowledge, and tools to
complete your research proposal and final research paper. Labs are also designed for you to acquire, at
the minimum, a working knowledge of the process involved in completing an experimental study from
start to finish. You will also learn or relearn statistical software, how to read output, and how to use APA
format in your papers. Lab assignments for the Wednesday lab are due the following Sunday at 11:59
p.m. unless otherwise noted. Lab assignments for Thursday lab are due the following Monday at 11:59
p.m. unless otherwise noted.

Participation Points (Class & Lab)

Reading the assigned material and completing the assignments before class and lab are important to
understanding the lecture topics and to participating in the discussions. Participation will be assessed
through in-class exercises, activities, and discussion. Exercises may occasionally be assigned in class in
order to help you to understand the course material. Some exercises will be worked on in class while
others may be worked on in class and at home. Lab participation will be graded based on the completion
of a specific assignment or demonstration that will take place each lab.

EXTRA CREDIT: Participate in Research Studies and Worksheets

Part of understanding the research process is being a participant in a study. You may participate in
research studies conducted in the psychology department to earn extra credit. All points will be applied to
your Blackboard CT Assignments. You can view and sign up for studies through the SONA system at
https://usc.sona-systems.com/. You may complete 10 points of credit on SONA. Half of your points
must be completed by participating in lab experiments and not survey research. For each study, you will
fill out a worksheet about the study. The worksheet will be posted on Blackboard after the third week of
class. Please note that your participation in research is voluntary and you have the right to NOT
participate in research studies. If you do not want to participate in studies, then you may complete the
alternative, which is writing two five page papers on two topics posted on Blackboard.
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Grading Scheme

A =100 -93.5%:; A-=93.4-89.5%; B+ =89.4 - 86.5%: B =86.4 - 83.5%; B- =83.4 - 79.5%; C+ =
79.4 -76.5%; C=76.4-73.5%; C-=73.4-69.5%; D+ =69.4 - 66.5%; D =66.4 - 63.5%; D-=63.4 -
59.5%; Below 59.5% = F

Statistics Background

All students in this class are required to have achieved a C- grade or better in their Statistics | course.
Students should have an introductory level of familiarity with descriptive and inferential statistics, their
interpretation, and writing of statistical results. Experimental Research Methods builds heavily upon your
background in statistics; students without an adequate background in statistics may find this course
difficult. We will thoroughly review common statistical methods. You should be able to identify the
appropriate statistics for each design type, depending on the scale of measurement used by the
researchers. You will be expected to be able to input data into SPSS, run the appropriate statistics, read
SPSS output, be able to infer the number of participants in the sample and levels of an independent
variable from degrees of freedom. All of these skills will be taught or reviewed in lecture and labs.

Instructor Student Communication and Blackboard

Blackboard (Bb) will be used to post announcements, send e-mails, and post all grades and course
materials, so it is the student’s responsibility to frequently visit the course on Blackboard (website:
http://blackboard.usc.edu). Bb transactions will follow the below guidelines.

1) Grades: All grades and points will be posted on Bb one to two weeks after the completion of
the exam, assignment, or activity. Grades will not be announced in class, via e-mail, or during
office hours.

2) Course Materials: The syllabus, lab assignments, and supplemental reading material can be
viewed and printed from Bb.

3) Announcements: Class announcements will be posted on Bb, as well as broadcasted in class.

4) Email: Any email communications from the instructor or TA will be sent via Bb or through the
USC’s email service. USC requires that all e-mail communication between the instructor and
students be sent via an official USC e-mail address. Any student communication delivered from
a non-USC e-mail address will be automatically discarded.

Tentative Schedule of Topics and Assignments

Topic Reading Deliverables
WEEK 1
Monday Overview of Course Syllabus N/A
08/25/2014
Wednesday » Purpose of the » None » None
08/27/2014 Course
» Psychological
Science as a
Career
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WEEK 2

Monday » Labor Day None N/A
09/01/2014 » No Class!
Wednesday » Scientific Chapter 1 In-class project
09/03/2014 Thinking (GOOD) (cont.)
Presentations
WEEK 3
Monday » Understanding Evans & In-class exercise
09/08/2014 Published Rooney
Research (2014)
Wednesday » Developing Ideas Chapter 3 In-class exercise
09/10/2014 » The Importance (GOOD) pp.
of Writing 73 - 86
Kline (2009)
WEEK 4
Monday » Understanding Chapter 3 In-class exercise
09/15/2014 Theories (GOOD) pp.
86-110
Wednesday » The Locke 12- Stephenson In-class exercise
09/17/2014 Step & Halpern and discussion
(2011)
WEEK 5
Monday » Ethics in Chapter 2 In-class
09/22/2014 Psychological (GOOD) pp. discussion
Science 35-40
Ethics
documents
Wednesday » Institutional Chapter 2 Lecture-
09/24/2014 Review Board (GOOD) pp. discussion
40 -"70
WEEK 6
Monday » Validity Chapter 4 In-class exercise
09/29/2014 » Reliability (GOOD) pp.
» Measurement 111 -126
Scales
Wednesday » Introductory Chapter 4 In-class exercise
10/01/2014 Review of (GOOD) pp.
Statistics 126 - 147
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WEEK 7

Monday Essentials of Chapter 5 In-class exercise
10/06/2014 Experiment (GOOD)
Research in
Psychology
Internal &
External Validity
Wednesday Sampling from Privitera In-class activity
10/08/2014 Populations (2014)
Power Analysis Denis (2003)
pp. 13 -17
WEEK 8
Monday Between- Chapter 6 In-class activity
10/13/2014 Subjects Design (GOOD) pp.
183 - 190;
203 -214
Wednesday Within-Subjects Chapter 6 In-class exercise
10/15/2014 Design (GOOD,) pp. and group
191 - 203 activity
WEEK 9
Monday Single Factor Chapter 7 In-class exercise
10/20/2014 Designs with 2 (GOOD) pp.
Levels 215 -226
Wednesday Single Factor Chapter 7 In-class exercise
10/22/2014 Designs with 3 (GOOD,) pp.
or More Levels 226 - 250
WEEK 10
Monday Factorial Designs Chapter 8 In-class activity
10/27/2014 (Basic) (GOOD,) pp.
251 -270
Wednesday Factorial Designs Chapter 8 Bring in a FULL
10/29/2014 (Varieties) (GOOD) pp. DRAFT of
271 -291 Proposal
WEEK 11
Monday False Positive Simmons et In-class exercise
11/03/2014 Psychology al. (2011)
Power & Value of Roediger
Replication in W (2012)
Science
Wednesday Alternatives to Denis (2003) In-class exercise
11/05/2014 NHST Fidler &
Significance, Cumming
Effect Size, & (2013)
Confidence
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WEEK 12

Monday Reporting Chapter 9 In-class exercise
11/10/2014 Results (BEINS)
Using Tables and
Figures to
Display Results
Wednesday Correlational Chapter 9 In-class exercise
11/12/2014 Research (GOOD)
WEEK 13
Monday Quasi- Chapter 10 In-class exercise
11/17/2014 Experimental (GOOD) pp.
Designs 329 - 350
Wednesday Introduction to Chapter 11 In-class exercise
11/19/2014 PSYC 316L (GOOD)
Observation &
Surveys
WEEK 14
Monday No Class N/A N/A
11/24/2014
Wednesday No Class! N/A N/A
11/26/2014 Thanksgiving
Break!
WEEK 15
Monday Abstracts Chapter 15 In-class exercise
12/01/2014 Fine Tuning Your (BEINS)
Writing
Wednesday Giving Oral Chapter 17 In-class activity
12/03/2014 Presentations (BEINS)
Kline (2009)
WEEK 16
Friday Research Presentations: 2:00 p.m. to 4:00 p.m.
12/12/2014 Final Research Paper Due TODAY at 11:59 p.m.
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Tentative Schedule of Labs

Topic Reading Lab Assignments: Due
11:59 p.m. on
Scheduled Day
WEEK 1
NO LAB
WEEK 2
LAB #1 » APA Format Chapters 1 » Title Page
» Microsoft Word (BEINS) » SPSS Data File
» SPSS » Summary of
Interviews
WEEK 3
Lab #2 » Evaluate Posted Chapter 5 » Complete
Article (BEINS) Evaluation of
» Create Groups Article
WEEK 4
Lab #3 » Finalize Groups Chapters 2, 3 » Complete
» Brainstorm Ideas & 4 (BEINS) Evaluation of
for Final Research Article
Paper
» Conduct Literature
Search for Final
Research Paper
WEEK 5
Lab #4 » Ethics Certification Article Found > Ethics
» Conduct Literature in Literature Certifications
Search for Final Search » Complete Locke
Research Project 12-Step on Article
WEEK 6
Lab #5 » Qualtrics Chapters 9 & » Prospectus for
» Finalize Topic for 14 (BEINS) Final Project
Final Research » Reference Section
Paper
» Reference Sections
WEEK 7
Lab #6 » Qualtrics Booth et al. » Introduction
(Advanced (2008) Section
Features) Chapters 6 &
» Research 10 (BEINS)
Questions &
Hypotheses
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WEEK 8

Lab #7 » Design Experiment Chapter 11 Methods Section
» Determine (BEINS)
Sampling
Procedures
WEEK 9
Lab #8 » Create Informed USC IRB Informed Consent
Consent Handbook Form
» Create Debriefing Debriefing
Statement Statement
» Work on Proposal
WEEK 10
Lab #9 » Work on Proposal Chapter 7 Research
(BEINS) Proposal Due
October 30t for
Wednesday Lab,
October 31st for
Thursday Lab
WEEK 11
Lab #10 » Create Materials Review Statement about
» Confounds Chapter Potential
» Finalize Design Chapter 4 Confounds
» Collect Data? (GOOD) pp. Affecting Internal
111 -126 & External Validity
WEEK 12
Lab #11 » Collect Data Chapter 8 SPSS File
» Create SPSS File (BEINS)
WEEK 13
Lab #12 » Collect Data Chapter 12 SPSS File with
» Enter Data (BEINS) Some Data
» Begin Analysis if Entered
Data Collection
Completed
WEEK 14
Lab #13 » No Lab! None None
» Collect Data
Though!
WEEK 15
Lab #14 » Abstracts Chapter 15 Abstract
» Analyze Data (BEINS) SPSS File
» Work on Final Completed

Paper

SPSS Output
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Statement on Academic Integrity

USC seeks to maintain an optimal learning environment. General principles of academic honesty
include the concept of respect for the intellectual property of others, the expectation that
individual work will be submitted unless otherwise allowed by an instructor, and the obligations
both to protect one’s own academic work from misuse by others as well as to avoid using
another’s work as one’s own. All students are expected to understand and abide by these
principles. SCampus, the Student Guidebook, (www.usc.edu/scampus or http://scampus.usc.edu)
contains the University Student Conduct Code (see University Governance, Section 11.00),
while the recommended sanctions are located in Appendix A.

Statement on Plagiarism

Plagiarism, lazy writing, and cheating are violations of the Student Judicial Affairs &
Community Standards and may be dealt with by both the instructor and the university.
Plagiarism is defined as, “the act of presenting the ideas and writings of another as one’s own.”
Lazy writing is defined as, “using quotes or paragraphs with the proper citation, but are used in a
manner that a paper is stitched together and clearly has little or no original writing.” Cheating is
defined as, “the act of obtaining or attempting to obtain credit for academic work through the use
of any dishonest, deceptive, or fraudulent means.” In instances of academic dishonesty, the
instructor will take appropriate action as outlined in the Academic Integrity Review Process
(SJACS 14.10). For more information on avoiding plagiarism or lazy writing, see Chapter 1,
Section 1.10 in the APA Publication Manual or visit http://www.usc.edu/student-affairs/student-
conduct/ug_plag.htm.

Statement for Students with Disabilities

Any student requesting academic accommodations based on a disability is required to register
with Disability Services and Programs (DSP) each semester. A letter of verification for approved
accommodations can be obtained from DSP. Please be sure the letter is delivered to me or to the
TA as early in the semester as possible. DSP is located in STU 301 and is open 8:30 a.m.—5:00
p.m., Monday through Friday. Website and contact information for DSP:
http://sait.usc.edu/academicsupport/centerprograms/dsp/home_index.html; Phone: (213) 740-
0776; TDD Only: (213) 740-6948; Fax: (213) 740-8216; email: ability@usc.edu.

Course Notes

1) Missed Assignments: Missed assignments cannot be made up and will result in a grade
of zero. Students who experience medical emergencies that prevent them from
attending class on days when class exercises or assignments are scheduled will be
required to provide original documentation from their physicians within one week
explaining their absence. USC athletes should meet with me as soon as possible
regarding their scheduled athletic events that may conflict with course requirements.

2) Feedback: Your lab instructor and I will make every attempt to return exams and
assignments in a reasonable time by returning them no later than two weeks after the
due date.

3) Appeal Process: If you find that an answer in an assignment or quiz was incorrect, but
you think it is correct, you can appeal the decision in writing. The written appeal must
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4)

5)

6)

have supporting documentation (e.g., reference to a class reading). The appeal cannot
be based on your opinion or personal experience, but rather based on the course
materials. Appeals must be delivered to the instructor no later than one week after the
grade is posted. Appeals will not be accepted via email and no late appeals will be
accepted.

Cell Phone and Electronic Device Policy: Cell phones should be turned off during
class. Do NOT leave cell phones on vibrate and do NOT text message during class.
Absolutely NO computers may be used during lectures. You may use your computer to
view an electronic version of an article during discussions. You must have a note from
the Disabilities Services and Programs that states it is necessary for you to use your
computer to take notes. Finally, no class or lab sessions may be video or audio
recorded.

Course Participation: You are expected to be prepared for class by completing the
required readings or exercises BEFORE class, and should be prepared for discussion of
the assignments (and participation point questions).

University Escort Service: If you feel that you would like to be escorted to your vehicle,
bus, or campus residence after 5:00 p.m., do not hesitate to call (213) 740-4911.

Special Notes

1)

2)

3)

4)

5)

This course is challenging and 100% attendance is expected of all students. There are
no exams, midterm, or final exam. You will, however, need to dedicate the time that
you would typically spend studying for tests to conducting your research and writing
high quality papers. As in any course, work of a significantly high caliber in each of
the components of this course is considered to be an A (i.e., exceptional work). Itis
especially important that you be on time for class, have completed your reading
assignments prior to class-time, and that you are prepared for discussion of these
materials in class.

All assignments in this course are expected to be word-processed and graphs/tables
should be computer-generated.

All assignments should be completed using APA-style, including the use of a title
page. Word processing and data management software are available in several
computer labs on campus. You should consult your APA Publication Manual for all
writing assignments.

All students are expected to have access to the student computer network. It is your
responsibility to ensure that your access is up-to-date during the semester.

Tutors are available for this course through the Learning Resource Center (LRC). If you
should find that you are not doing as well in this course as you would like, please see
me immediately. | will help you: It is my job! You can also arrange short-term or long-
term tutoring through the LRC. The Writing Center is also available to tutor students
who are having difficulty with writing. For assistance, visit their website at
http://college.usc.edu/writingcenter/ or call (213) 740-3691.
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Emergency Preparedness/Course Continuity in a Crisis

In case of a declared emergency if travel to campus is not feasible, USC executive leadership
will announce an electronic way for instructors to teach students in their residence halls or homes
using a combination of Blackboard, teleconferencing, and other technologies.

Statement of Course Content as a Copyright

It is important to know that all material presented in class, labs, or discussion sent via email or
posted on Blackboard is “all rights reserved” by the course instructor. In addition, some of it is
copyrighted and distributed by a publishing corporation for in-class use only. You may not store,
post, or distribute any course materials—on paper or electronically--for use by any student not
presently enrolled in this course. Out of fairness to all current and future students, please do
your part to protect our course content.

Svllabus as a Contract
The purpose of this syllabus is to provide a contract between the instructor and the student. By

enrolling in this class, you agree that you have read, understand, and will adhere to the syllabus
guidelines and complete the assignments given in the class. | reserve the right to change the
schedule of topics and readings and I will give notice to you of such changes well in advance of
those changes.

P owrer

o= 05
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